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SPECIFICATIONS

SYSTEM

REQUIREMENTS

Windows® 95/98/ME/NT4/2000/XP

COMMUNICATION

RS-232 adapter or RS-422/485 adapters with an
RS-232 to RS-485 converter may be used for
communicating with the meter(s)

NUMBER OF Up to 100 meters simultaneously with addressing
METERS capability (up to 60 seconds scanning delay)
BAUD RATE 2400 bps to 19.2 kbps

Data logging: log to HTML file format

Configuration: save configuration to PDC file format
A or export to HTML file for printing, cloning, or

restoring meter settings
CONFIGURATION Configure one meter at a time

Log data to HTML file. All enabled meters are
LOGGING logged to a single file.

Logging interval: 2 seconds to 60 hours or manual

ORDERING INFORMATION

METERVIEW 3 INSTALLATION

1. Load the MeterView 3 CD-ROM into your CD-ROM drive.
The MeterView 3 CD browser should load automatically. If
it doesn’t, click on the Start button on the Windows®
taskbar, then click Run. Type x:\Autorun.exe (where x is
your CD-ROM drive) and press enter.

"%, Precision Digital Corporation @
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METERVIEW VERSIONS
Model Description
PDA7503-1 Supports 1 meter
PDA7503-2 Supports up to 10 meters 2. Al C(.)nt(.ents of the CD are accessible from the CD browser
by clicking any of the buttons on the screen. Click on the
PDA7503-3 Supports up to 100 meters first button on the left to install MeterView.
3. During installation, the MeterView 3 program icon is
METER MODELS placed on the Windows Desktop and also in the Start
85-265 VAC* 12-36 VDC* . Menu with other related icons.
Model Model | g 4. Afterwards, the MeterView 3 CD browser may be used to
PD765-6R0-00 | PD765-7R0-00 | No options access the rest of the CD-RQM conte.n.ts, [ncludlng:
1 YRV, - | instruction manuals, a readme file contalnmg important
PD765-6R0-10 transmitter supply information about MeterView, free Adobe® Acrobat®
PD765-6R2-00 | PD765-7R2-00 | 2 relays software for viewing PDF files, etc.
PD765-6R2-10 2 relays & 24 V transmitter supply
PD765-6R3-00 | PD765-7R3-00 | 4-20 mA output Notice!

PD765-6R3-10

4-20 mA output & 24 V supply

PD765-6R3-20

4-20 mA output & dual 24 V supplies

To request meters with Modbus option enabled, replace the last digit with a “1”.
Modbus option may be ordered separately by requesting P/N: PDN-MODBUS
*All models may be powered from AC or DC, see PD765 Instruction Manual for details.

ACCESSORIES
Model Description
PDA7420 7' (2.1 m) Standard Modular Cable
PDA7232 RS-232 Serial Adapter (includes PDA7420)
PDA7422 RS-422/485 Serial Adapter (includes PDA7420)
PDA7485 RS-232 to RS-485 Converter
PDA7486 120 VAC/12 VDC Power Supply
PDA7487 DB25 to DB9 Adapter

This software may only be installed on a single computer. It
may not be shared over a network or otherwise used on more
than one computer at a time, except for the purpose of remote
programming of meters. For complete terms refer to the End
User License Agreement (EULA) found in the MeterView 3
registration window.




MeterView® 3 Software Instruction Manual

Enable Meter and Select Meter Address
METERVIEW 3 VERSIONS
MeterView 3 comes in three different versions: The actual meter address is set up at the meter. using the fropt
panel buttons. The location where a meter is displayed is
e PDA7503-1 — Supports 1 meter selected on MeterView Main window.
(T REX| To enable or select a meter with a different serial address:
=L o 1. Right-click on the screen location of meter.
MereHs - ;ﬁ m 2. Click on Enabled, if meter is not yet enabled.
it or s | oo | 3. Click on Change Address.

Select meter address to display in this location.
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& COM1 (4 00 [ Update ate: 1 sec E Loggngstopped @ 1053 |[=1 3/13/2008
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The main MeterView 3 window shows the present
reading(s), relays/alarm status, tag number(s) and selected
engineering units, along with other information for each
meter. The graphic below indicates the different parts of the

& 1018 |2 3/13/2003

¢ PDA7503-3 — Supports up to 100 meters

main MeterView 3 window.
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RUNNING METERVIEW 3 THE FIRST TIME

The first time MeterView 3 is run it is necessary to set up the
serial communication settings of the program. Select the

communication port and the baud rate of the meter(s)
connected.

@Serial Setup .

B | compant

Engineering
units

2400 | Baud Lancel
Tag number
Note: The selected baud rate in MeterView and the meter(s) baud rate
must be the same. Otherwise a communication error will occur. Relays/alarms

status indicators

Address being scanned Logging System date
# 00 Y& Update aie: 1 500
£
COM port  Update/scan System time
used




MeterView® 3 Software

Instruction Manual

Main Window Menus

The MeterView 3 main window contains the following menus:
e File menu
o Edit menu
e View menu
e Comm Menu
e Help Menu

File Menu
The following options are available from this menu:
1. Save Settings to save the present window settings.
2. Exit to close the MeterView 3 program.

Edit Menu
The following options are available from this menu:

1. Serial Settings to edit the serial communication settings.

View Menu
The following options are available from this menu:

1. Event Log to view the MeterView 3 event log window
where all internal program events and errors are logged.

2.Show Relay Alerts select whether or not MeterView
should alert the user of a change in the relay status (ON
- OFF or vice versa) with a pop-up message.

Comm Menu
The following options are available from this menu:

1. Stop to halt the automatic meter scanning. This allows
quicker access to menu items, functions, and windows.

2. Start to resume the automatic meter scanning.

Help Menu
The following options are available from this menu:

1. Register MeterView 3 to launch the registration program
to register your copy of MeterView 3.

2. About opens a window that provides the product number
and version information. You should have this information
available in the event you must contact Precision Digital
Technical Support.

I About MeterView 3

MeterView 3

Wersion 3.01 - Build 0200

PRECISION
DIGITAL =
Sustem Infa...

Licansed o FDC Emainies
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e A T - e

Right Click Menu

By right clicking on a meter on the screen a menu will
appear with the following options:

Menu ltem Function/Submenus
Enabled Enable or disable a meter on the screen
Change Address Change a meter’s serial address in MeterView
Mode Select whether relays/alarms are shown or not
Configure Access the configuration window for a meter
Customize Customize how a meter looks on the screen

i
v Enabled
Change Address | |
Mode 3 Mo Relays
Configure v Relays
| Cuskomize
Notes:

¢ Due to the intensive processor usage, it may be necessary
to click more than once before a submenu or function is
launched.

e Accessing menus or other windows could disrupt
communication with the meter(s).

e Use left mouse button or tab key on the keyboard to
navigate within a window.

e Parameters not available within a window appear grayed-
out.

¢ An arrow next to a box indicates a drop-down menu. Click
on arrow to display the drop-down menu.
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CONFIGURATION WINDOW

Click on Configure in the right click menu to open a meter's
configuration window. The following settings can be
programmed from this window:

1. Input type (4-20 mA, 0-10 V, RTD, or TC).

2. Decimal point for process inputs (dd.dd).

3. Units (F or C) and sensor type for temperature inputs.

4. Values for scaling process inputs, values for scaling
analog output, Password, Adjust (temperature only),
Filter, Bypass, Cutoff (process inputs only), Transmit
Delay, Function type, and Cut-off.

5. Relay settings.

6. After the last change has been made, click the Write to
Meter button or press Enter on the keyboard to send the
new settings to the meter, or click on Exit to abandon
changes. Before sending the new settings, MeterView 3
will ask to confirm that the meter’s current settings should
be overwritten. Click Yes to overwrite the settings, or No
to abort the operation and return to the configuration
window.

The configuration window contains the following menus:
e File menu
e Tools menu
e Password menu

Note:

e Accessing menus or other windows could disrupt
communication with the other meter(s).

File Menu

The following options are available from the File menu:
1. Save Configuration to save the present settings to a file.
2. Load Configuration to load settings from a file.

3.Export to HTML to save the present settings to a HTML
file.

4. Import from HTML to load settings from a HTML file.

Tools Menu

The following options are available from the Tools menu:
1.Restore Meter to restore a meter to settings previously
saved in a configuration file. The restore operation will
only work with the meter whose settings were originally
saved to the file.

2. Load Defaults to load the factory default settings.

It is recommended to create a
configuration file before
changing any setting and before
any calibration operation.

Password Menu

The following options are available from the Password
menu:
1.Lock Meter to lock the meter and prevent unauthorized
changes.
2.Change Password to change the unlock password of the
meter.
3. Unlock Meter to unlock the meter and allow changes to be
made.

The password must be a four-digit
number; “0000” is the unlocked
password setting.

Input Tab

In the configuration window, click on the Input tab to view
the input options.

H Meter Configuration - Meter #00 @
File Tools Password
Input | Scaling | Relaps/Alams | Advanced | Factory Values |
Input Type Temperature Unit
410 20 md i
Decimal Point Temperature Sensor

dd.dd -

frite to Meter Read Meter Exit

|20 Source of configuration: Default sellings.
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Set Up Input Type

Click on the arrow next to the 4 to 20 mA box and then click
on the desired input type.

Input Type
4t020ms

4 ko 20 mé,
Oto 10

Themocouple
RTD

11 44 =1

=

Set Up Decimal Point

Click on the arrow next to the dd.dd box and then click on
the desired decimal point position. Decimal point selection
is available for 4-20 mA and 0-10 V inputs only. The display

scale and relay set/reset points are adjusted according to
the decimal point selection.

Decimal Point

dd.dd -]

ddd.d
dd.dd
d.ddd
diddd

Set Up Temperature Unit

Click on the arrow next to the Degrees F box and then click
on the desired temperature unit. Temperature unit selection
is available for Thermocouple and RTD inputs only.

Temperature Unit
Deqgrees F _:J

Degrees C

Set Up Temperature Sensor

Click on the arrow next to the Type J box and then click on
the desired temperature sensor. Temperature sensor

selection is available for Thermocouple and RTD inputs
only.

Thermocouple Sensors RTD Sensors

Temperature Senzor

|T_-,Ipe.J _:_J Temperature Sensor
Toned 100 Ohm PLRTD (385] v

%Ez ? 700 Ohm ELET D 13851
e s 100 Obm PERTD [232]

Type E

Scaling Tab

In the configuration window, click on the Scaling tab to view
the scaling settings for process inputs (current and voltage).

1T Meter Configuration - Meter #00 @
File Tools Password

Input {Sealing ] Relays/Alamms | Advanced | Factory Values |

Current (mA] Voltage (V)
Input 1 Display 1 Input 1 Display 1
[ 4.00 | 4.00 | 0 [
Input 2 Display 2 Input 2 Display 2
[ 2000 | om0 | 0 [

ﬂ—ﬂ@ write o Meter Bead Meter Exit

|20 Source of configuration: Default sellings.

Relays/Alarms Tab

In the configuration window, click on the Relays/Alarms tab
to view the settings for the relays/alarms.

H Meter Configuration - Meter #00 @

File Tools Password

Relay/Alarm 1 Relay/Alarm 2
Fail-Safe |~ Fail-Safe [
Hode Mode
[ Automatic Reset = | Automatic Reset ~|
Set Point On Delay [ms] Set Point On Delay [ms)
| 700 [ 0 | 1000 [ 1
Reset Point OFf Delay [ms) HReset Point Off Delay [ms)
| em0 [ i | am [ i

iz toMeter | Read Meter | Exit

2] Source of configuration: Default settings.

Advanced Tab

In the configuration window, click on the Advanced tab to

view the advanced settings. Consult the meter manual for
further details.

H Meter Configuration - Meter 00 @
Eile Tools Password

Input | Scaling | Relays/Alarms {Advanced | Factory Values |

Adjust Yalue Lockout Installed

,—UE o Status DOption Relays =
Analog Output [mA)
Filter Value Intensity

Display 1 Dutput 1

4.00 4.00

Bypass Value Function Type Displap 2 Dutput 2
[ uex [Linear = 20,00 2000
Transmit Delay Cutoff Value

Wms I~ RS422 W Sensor Break 3.00

[ o [

Swfrite o Mater I Bead Meter ] Exit ]

2 Source of configuration: Default settings.
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Factory Values Tab

In the configuration window, click on the Factory Values tab
to view the meter serial number, version, and calibration
constants.

H Meter Configuration - Meter #00 @
File Tools Password

Input] 5caling} Relaysmlalms] Advanced ; Factory Values ]
Intamal Calibration Valuss
Firmware Number Gain  Dffsst Cr
[ ;s Curent 0030445 (2010490
Voltage 0071818 -0 4457163
e Test NEAN0N -0 OBN7ON0
TCTyped 10413320 7AD4GED 3363005
FE TCType K 10414040 7FRIAI0G 3330575
TCType T 10402630 7700743 3332035
Meter Serial Mumber | TC Type B 10416330 B101335 3332675
[ owioiiss | RTDASS 10318330 6425083
RTD A392 10318320  £425.099
Analog Dut 250000000 -10,0000000

H@ wfrite o Meter Head Meter Exit

|2 Source of configuration: Meter at address 00

CUSTOMIZE WINDOW

Click on Customize in the right click menu to open a meter’'s
customize window. The following settings can be
programmed from this window:

1. Tag Number to identify a meter and optionally display it on the
meter. Pre-selected special characters may be used in this field
by simply dragging the desired symbol into it.

2. Display Units to identify the engineering units of the value being
read and optionally display it on the meter. Pre-selected special
characters may be used in this field by simply dragging the
desired symbol into it.

3. Display Color to change the color of the meter display on the
screen.

4. Relay Tag to change the text label of the Relay Status
indicator(s).

5. Relay Color to change the color of the Relay Status indicator(s).

& Customize Meter - Meter Meter #00
Tag Humber Special Symbols
v Shon Dk et chag basind

A madd | | ot 3 fethor

Meter HOO A EEEBE EBEE
Display Units IMEREAEE
v Show
# et mad | - Display Color
i
Relay 1 Relay 2
Ontag /i cham mas Ontag /i cham mas
|on |on
On color On color
Off tag /i cham s Off tag /i cham masi
|oit |oit
Off color Off color
oK LCancel |

Note:
¢ These settings are NOT saved to the meter.

SERIAL COMMUNICATION SETUP

Addresses for Trident Meter
and MeterView 3 are set to 00
at the factory.

1.From the main window, click on Edit > Serial Settings
menu to access the Serial Communication Setup.
2. Select correct communication port used for Serial Adapter.

3. If timeout error is received, try another serial port selection
or check meter’s address.

To change the serial address of a meter, simply click on
Change Address in the right-click menu. This setting is on a
per-meter basis.

ﬂ% Change Meter Address @
Current Address:
L] Ok
New Address:
Cancel
] i A—]

Note:
e Baud rate is set up for 2400 bps at the factory.

RELAYS/ALARMS STATUS

Each meter enabled in the main MeterView 3 window can
display the current status of its relays/alarms (if the meter
Mode in the right-click menu is set to Relays) and can allow
the user to remotely acknowledge the relays/alarms (if
applicable). The text labels and colors for the status indicators
may be customized through the Customize window.

Meter #00

=
i1 F

|Cli|:k ko aknowledge relay,l'alarm|

Note:

e See the PD765 Instruction Manual for more information
about relay operation and acknowledgement.
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LOGGING METER DATA TO FILE

1.Click on the arrow next to the Interval box to select an
interval from 2 to 60 or select manual to log the data only
when the Log button is clicked (Log button is only visible
when manual is selected).

2. Select seconds, minutes, or hours.

3. Click the Start button.

4.Select file location and enter a file name. Click OK.
MeterView 3 will begin logging data to the file.

Logging Settings -
Intervak:

Logging may be paused or stopped at any time. MeterView 3
will indicate logging and paused status with corresponding
message flashing in the main window status bar. When
logging, all other MeterView functions and windows are not
accessible.

Log File Sample

The HTML log file format contains pertinent information
related to the meter and logging selections. Each log entry
includes date and time, tag number, serial address, display
value, units and relays/alarms status.

Disclaimer:

The information contained in this document is subject to
change without notice. Precision Digital makes no
representations or warranties with respect to the contents
herein, and specifically disclaims any implied warranties of
merchantability or fitness for a particular purpose.

MeterView® is a registered trademark of Precision Digital
Corporation.

Microsoft, Windows, Windows NT, Microsoft Internet Explorer,
and the Microsoft Internet Explorer logo are either registered
trademarks or trademarks of Microsoft Corporation in the
United States and/or other countries.

Adobe, the Adobe logo, Acrobat, and the Acrobat logo are
either registered trademarks or trademarks of Adobe Systems
Incorporated in the United States and/or other countries.

How to Contact Precision Digital

¢ For Technical Support please
call: (800) 610-5239
fax: (508) 655-8990
email: support@predig.com

¢ For Sales Support or to place an order
please

call: (800) 343-1001
fax: (508) 655-8990
email: sales@predig.com

e For an online version of this Instruction
Manual
please visit

www.predig.com

e For Interactive VirtualMeter Demo please
visit

www.predig.com

LIM7503_B
SFT024 v3.01 & up
12/03



